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System Storage DCS3700 Quick Start Guide

This Quick Start Guide describes the basic procedure for installing and configuring the IBM® System
Storage® DCS3700 storage subsystem and the DCS3700 storage subsystem with Performance Module
Controllers and expansion units.

Related documentation
For detailed information about the DCS3700, DCS3700 storage subsystem with Performance Module
Controllers, and expansion units, see the IBM System Storage DCS3700 Storage Subsystem and DCS3700
Storage Subsystem with Performance Module Controllers Installation, User's, and Maintenance Guide. For safety
information, see the multilingual IBM Safety Information document on the Support DVD that ships with
the enclosure.

For more information about how to use a lift tool to install the storage enclosure, see the documentation
that came with your lift tool.

For educational information about the DCS3700, DCS3700 storage subsystem with Performance Module
Controllers, and other IBM System Storage products, go to http://ibmdsstorage.com/. For the latest
information about IBM System Storage disk storage systems, go to http://www.ibm.com/systems/
support/storage/disk.

Installation overview
The installation of the storage enclosure involves the following procedures:
1. “Installation guidelines”
2. “Ordering the lift tool” on page 4
3. “Unpacking the shipping box” on page 5
4. “Installing the support rails and rear brackets” on page 8
5. “Installing and removing the handles” on page 10
6. “Installing the storage enclosure in the rack cabinet” on page 11
7. “Installing the DDMs” on page 13
8. “Turning on the power” on page 15
9. “Installing the software” on page 16

10. “Discovering and setting up the storage subsystem” on page 16
11. “Obtaining information from the IBM Support Web site” on page 18
12. “Updating the storage subsystem firmware” on page 19
13. “Configuring the storage subsystem” on page 19

Installation guidelines
Before you install the DCS3700, DCS3700 storage subsystem with Performance Module Controllers, and
expansion units in a rack cabinet, review the following guidelines:
v This product is to be installed and serviced only by qualified IBM service representatives.
v Because of the size and weight of the storage enclosure as shipped, a lift tool and a minimum of two

trained service technicians are required to push the enclosure out of its custom-designed package and
onto the lift tool.

v The storage enclosure must not be installed in a rack position where the top of the unit is above 32U
or the bottom of the unit is above the 29U mark on the rack cabinet.

http://ibmdsstorage.com/
http://www.ibm.com/systems/support/storage/disk
http://www.ibm.com/systems/support/storage/disk


v Do not block any air vents; usually 15 cm (6 in.) of space provides proper airflow.
v Do not leave open spaces above or below an installed storage enclosure in your rack cabinet. To help

prevent damage to storage enclosure components, always install a blank filler panel to cover the open
space and to help ensure proper air circulation.

v Install the storage enclosure only in a rack cabinet with perforated doors.
v Plan the device installation starting from the bottom of the rack cabinet.
v Install the heaviest device in the bottom of the rack cabinet.
v Do not extend more than one device out of the rack cabinet at the same time.
v Remove the rack doors and side panels to provide easier access during installation. Depending on the

rack location where the storage enclosure will be installed, you might need to remove the bracket that
holds the door to the rack because the bracket might obstruct the storage enclosure handles.

DANGER

Connect the storage enclosure to a properly grounded outlet. The storage enclosure accepts only 200
V - 240 V input sources. If you do not have an IBM rack with the supported PDUs and 60 A power
cords, check your PDUs or input sources to ensure that they can handle the voltage and currents of
the DCS3700 storage subsystem and DCS3700 storage subsystem with Performance Module
Controllers. Do not overload the power outlet when you install multiple devices in the rack
cabinet.

v Install the storage enclosure in a rack cabinet that meets the following requirements:
– Minimum depth of 70 mm (2.76 in.) between the front support flange and the inside of the front

door.
– Minimum depth of 157 mm (6.18 in.) between the rear support flange and the inside of the rear

door.
– Minimum depth of 762 mm (30 in.) between the front and rear support flanges to support the use of

the cable-management arm.
v For more information about installing the storage enclosure in a non-IBM rack, see the “Specifications

for non-IBM rack installation” section in the IBM System Storage DCS3700 Storage Subsystem and
DCS3700 Storage Subsystem with Performance Module Controllers Installation, User's, and Maintenance
Guide.

56.7 kg (125 lbs)102 kg (225  lbs)

(12 x 5)

(60X)
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Attention:

1. Because of the size and weight of the storage enclosure as shipped, a lift tool and a minimum of two
trained service technicians are required to push the enclosure out of its custom-designed package and
onto the lift tool. If a lift tool is not available, see Appendix E, “Component weights”, in the IBM
System Storage DCS3700 Storage Subsystem and DCS3700 Storage Subsystem with Performance Module
Controllers Installation, User's, and Maintenance Guide for additional information.

2. If you want to move or relocate a DCS3700 storage subsystem or a DCS3700 storage subsystem with
Performance Module Controllers, or a rack containing these subsystems or enclosures; see IBM System
Storage DCS3700 Storage Subsystem and DCS3700 Storage Subsystem with Performance Module Controllers
Installation, User's, and Maintenance Guide.
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Ordering the lift tool
The use of a lift tool is required when you install a DCS3700 storage subsystem or DCS3700 storage
subsystem with Performance Module Controllers in a rack cabinet, and when you remove the DCS3700
storage subsystem or DCS3700 storage subsystem with Performance Module Controllers from a rack
cabinet. Ensure that the lift tool is available on location at the time of the installation. The ordering
procedure for the lift tool varies depending on your location. Ask questions about these procedures to
your regional representative.

World trade locations
The following ordering procedures are for world trade locations:
v Order the lift tool by using the parts ordering system, as you would with any other part.
v Use the part number 09P2481 when you order.
v Do not record parts usage.
v Return the lift tool to the parts center after you complete the installation or removal of the DCS3700

storage subsystem or DCS3700 storage subsystem with Performance Module Controllers.

United States locations
In the United States, call UPS Logistics at 800-528-6070 to order the lift tool or visit the MTS/Test
Equipment Service Center Web site on the IBM intranet at http://pokgsa.ibm.com/~tstesc/public/ for
additional information.

Note: The MTS/Test Equipment Service Center Web site can be accessed only by IBM employees with
access to the IBM intranet.

For the SSR branch and territory, the United States cannot order the lift tool through the parts ordering
system. UPS Logistics is used to ship and return the lift tool. Use the part number 09P2481 when you
order the lift tool.

You must provide the following information when you order the lift tool. This information is necessary to
ensure that the lift tool is delivered when you need it. Failure to provide this information might delay the
completion of the order request and the shipping request. It might also result in a time and date to return
the tool that is different from what you need.
v Phone number and customer contact
v Account code: 98577
v Time and date of delivery
v Accurate destination address with zip code
v Time and date of return pickup

Note: When you order the lift tool, you will receive an 18-inch load plate.

You must return the lift tool at the time that you schedule with UPS Logistics. If you need to change the
scheduled return time or date, contact UPS Logistics. You are responsible for ensuring that all of the
paperwork and components are packed and restored in the lift tool shipping container. Ensure that the
lift tool is functioning properly before you release the tool to UPS Logistics for return. You are
accountable for the lift tool until UPS Logistics picks up the lift tool for return delivery to their parts
storage facility. Contact your branch office tools coordinator or your region specialist if you have any
questions or concerns.
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Unpacking the shipping box

Important: Do not remove the storage enclosure from the shipping box until the support rails are
installed in the rack cabinet. You must install the support rails in the rack cabinet before you
install the storage enclosure.

The disk drive modules (DDMs) that come with the storage enclosure are packaged in a smaller box
inside the shipping box. To unpack the shipping box, complete the following steps:
1. Remove the following items from the shipping box. Do not remove the DCS3700 storage subsystem or

DCS3700 storage subsystem with Performance Module Controllers from the shipping box at this time.
v Six full or empty boxes of DDMs

Note: The DDMs are packaged ten per box. The minimum order is 20 DDMs, so at least two of the
boxes are full. If you ordered less than the maximum number of 60 DDMs, one or more of
the boxes are empty.

v Box containing the mounting hardware kit
v Box containing storage enclosure handles
v Box containing the power cords and documentation

Note: If you plan to use Remote Customer System Inventory (RCSI), before starting this install, use
the bar code label process for proper component tracking.

The RCSI application automates the inventory checking tasks prior to installing a system or a
miscellaneous equipment specification (MES). The IBM service representatives must install the
application on their notebooks, download the packing list of parts to the notebooks using the
RCSI application, then use a bar code scanner to scan the parts that are shipped. The
application processes the scanned parts and informs the service representatives of any missing
parts or extra parts. With this process, the service representatives can ensure that they received
all parts that are required to install an IBM system or MES.

You can find the RCSI application guides and resources at: http://pokgsa.ibm.com/~tstesc/
public/

2. Check the items in the preceding list to ensure that you received all the necessary parts. See the
“Inventory list” on page 6 for the parts that are included with the storage enclosure.
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Inventory list
The following illustration and inventory list show the items that you need to install the storage enclosure
in the rack cabinet. If any items are missing or damaged, contact your place of purchase.

Notes:

1. The illustration might differ slightly from your hardware.
2. Depending on your order for the DCS3700 storage subsystem or DCS3700 storage subsystem with

Performance Module Controllers, your shipping box might contain additional materials that are not
shown in the following illustration.

Support rails

Storage
enclosure

M5 x 8 mm
screws (16)

PDU jumper cord

Rear brackets

Bezel

Clip nuts (4)

Fan
assembly (2)

Power
supply (2)

Controller
or ESM (2)

Drive drawer
assembly (5)

Disk drive module
(20 or more)

Handles (4)
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After you unpack the DCS3700 storage subsystem or DCS3700 storage subsystem with Performance
Module Controllers, verify that you have the following items:
v 4U-high storage enclosure (1)

– Drive drawer assemblies (5)
– Fan assemblies (2)
– Power supplies (2)

6



– Controllers (2), if you ordered 1818-80C
– ESMs (2), if you ordered 1818-80E

v Handles (4), packaged in a smaller box inside the shipping box
v DDMs (20 or more, depending on your order), packaged in a smaller box inside the shipping box
v Bezel (1)
v Rack-mounting hardware kit (1), packaged in a smaller box inside the shipping box, including:

– Rails (2), right and left assembly
– Rear brackets (2)
– M5 black hex-head slotted screws (16)

Note: The screws are either preinstalled in the support rails or packaged in a plastic bag.
– Washers (8)
– Clip nuts (4)

Important: The DCS3700 storage subsystem or DCS3700 storage subsystem with Performance Module
Controllers do not ship with region-specific ac power cords. You must obtain the
IBM-approved power cords for your region. See the IBM System Storage DCS3700 Storage
Subsystem and DCS3700 Storage Subsystem with Performance Module Controllers Installation,
User's, and Maintenance Guide. for more information.

Tools
Before you install the storage enclosure, the installation area must have an Internet connection, and you
must have the following tools:
v A lift tool to hold the storage enclosure and its components
v Labels for the cable connectors
v A medium flat-blade screwdriver
v A No. 2 Phillips screwdriver or an M5 hex driver
v Anti-static protection
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Installing the support rails and rear brackets

Note: Use the front and rear rack-mounting templates on pages 19 and 20 to align the support rails and
rear brackets with the correct rack holes. If the support rails will be installed above an existing
storage subsystem or storage enclosure, position the DCS3700 or DCS3700 storage subsystem with
Performance Module Controllers support rails directly above it. If the support rails will be installed
below an existing storage subsystem or storage enclosure, allow 178 mm (7 inches) of vertical
clearance for the DCS3700 or DCS3700 storage subsystem with Performance Module Controllers.

To install the left and right support rails in the rack cabinet, complete the following steps. Use the front
and rear rack-mounting templates on pages 20 and 21 to align the support rails and rear brackets with
the correct rack holes. If the support rails will be installed above an existing storage subsystem or storage
enclosure, position the DCS3700 or DCS3700 storage systems with Performance Module Controllers
support rails directly above it. If the support rails will be installed below an existing storage subsystem
or storage enclosure, allow 178 mm (7 in.) of vertical clearance for the DCS3700 storage subsystem or
DCS3700 storage subsystem with Performance Module Controllers.
1. Ensure that the rack has already been installed.
2. Ensure that a stabilizer has been attached correctly to the bottom front of the rack to prevent the

rack from tipping forward while the storage enclosure is being installed.
Refer to the installation and service guide, or equivalent, for the rack as required.

3. Locate the two support rails, eight M5 screws, and eight washers that are supplied with the storage
enclosure.

Note: The screws and washers might already be attached to the support rails. If so, remove them
from the support rails.

4. Starting with the left support rail, loosen the two rail adjustment screws with a medium flat-blade
screwdriver. The adjustment screws are used to lock the support rails at a certain length.

Note: The support rails are not marked as left or right. However, each rail can be mounted correctly
on only one side of the rack cabinet. The rails should be mounted with the alignment pin at
the rear of the rack.

Front

Rear

Front rack
cabinet rail

Screws

Support
rail lip

Rail adjustment
screws

Rear rack
cabinet rail

Screws

5. Hold the front of the left support rail against the inside of the front rack cabinet support flange, and
extend the rear of the support rail until it makes contact with the rear rack cabinet support flange.
The alignment pins at the rear of the support rail slide into the mounting holes at the rear of the
rack cabinet. The wider end of the support rail must be positioned at the front of the rack cabinet.
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6. From the front of the rack cabinet, with the support-rail flanges positioned inside the rack cabinet
support rail assemblies, insert two M5 screws with washers through the front of the cabinet and
screw them into the support rail front flange. Ensure that you use a washer when you install an M5
screw through a square hole on a rack-mounting flange.
Attention: Ensure that the screws are tight enough to support the weight of the storage enclosure,
but do not completely tighten the screws yet.

7. Ensure that the holes in the rail above and below the top mounting screw are visible through the
holes of the rack flange and tighten the two M5 screws to secure the front of the rail to the rack
flange.

8. From the rear of the rack cabinet, insert two M5 screws with washers through the rear of the cabinet
and screw them into the support rail rear flange.

9. Tighten the two rail adjustment screws with a medium flat-blade screwdriver.
10. Repeat steps 4 on page 8 through 9 for the right support rail.

Note: Because the mounting holes on the rack are not always the same size as the mounting screws,
the lip of each of the support rails might not line up evenly. Make minor adjustments as
needed to ensure that the lip of the left and right support rails are lined up evenly on the
racks. Failure to do so will cause the storage enclosure to fit unevenly in the rack.

11. Locate the two rear brackets, four M5 screws, four washers, and four clip nuts that are supplied with
the storage enclosure.

12. Install the rear brackets at the rear of the rack as shown in the following illustration, using the M5
screws, washers, and clip nuts to secure the brackets to the rack mounting holes.
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Installing and removing the handles
Install the handles on the storage enclosure before you move the unit onto the lift tool. After you install
the storage enclosure in the rack cabinet and remove the handles, store the handles for future use.

Installing the handles
Complete the following steps to install the handles on the storage enclosure:
1. Locate the box of handles.
2. To install a handle on the storage enclosure, place notch at the bottom of the handle in the opening in

the storage enclosure chassis, and push the handle in and up until the latch at the top of the handle
secures the handle to the chassis.

3. Repeat step 2 for the three remaining handles.

Removing the handles
Before you install the storage enclosure completely into a rack cabinet, you must remove the handles.
Complete the following steps to remove the handles from the storage enclosure:
1. To remove a handle to the storage enclosure, release the latch with your thumb and pull down and

away from the unit.
2. Repeat step 1 for the three remaining handles.
3. Store the handles for future use.

Thumb
latch

Handle
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Installing the storage enclosure in the rack cabinet
To install the storage enclosure, complete the following steps.

Note: For more information about how to use a lift tool, see the documentation that came with the lift
tool.

1. Prepare the storage enclosure for installation:
a. Position the lift tool so that it is facing one side of the shipping box.
b. Remove the foam shipping material from the sides and ends of the storage enclosure.
c. If necessary, cut away the sides of the shipping box so that the lift tool has access to the storage

enclosure.
d. Open the plastic bag and tuck it under the storage enclosure. The plastic bag reduces friction and

makes it easier to slide the unit off of the shipping box onto the lift tool, and off of the lift tool
and into the rack cabinet.

e. Install the four handles on the sides of the storage enclosure. See “Installing and removing the
handles” on page 10 for detailed instructions.

56.7 kg (125 lbs)102 kg (225  lbs)

(12 x 5)

(60X)

Attention: Because of the size and weight of the storage enclosure as shipped, a lift tool and a
minimum of two trained service technicians are required to push the enclosure out of its
custom-designed package and onto the lift tool. If a lift tool is not available, see Appendix E,
“Component weights”, in the IBM System Storage DCS3700 Storage Subsystem and DCS3700 Storage
Subsystem with Performance Module Controllers Installation, User's, and Maintenance Guide. for additional
information.

2. With the help of a lift tool and a minimum of two trained service technicians, or a lift tool and
professional movers, slide the storage enclosure off of the side of the shipping box and onto the lift
tool. Align it in front of the rack.

3. Put the rear edge of the storage enclosure on the support rails.
4. Remove the two handles (one on each side) at the rear of the storage enclosure. Do not remove the

front handles on the sides of the unit.
5. Slide the storage enclosure halfway into the rack. Remove the remaining two handles at the front of

the unit.
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Rear

6. Install and tighten two M5 screws on each side of the rack, above and below the top M5 screws, in
the front of the storage enclosure to secure the chassis to the rack flanges.
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7. Tighten all of the M5 screws to secure the rear of the storage enclosure to the rack cabinet.
8. Turn the rear-bracket thumbscrews to attach the rear brackets to the sides of the storage enclosure.

The screw holes are located about 51 mm (2 in.) from the rack flange.

Note: To align the thumbscrews with the holes in the unit, you might need to loosen the screws that
attach the rear brackets to the rack cabinet.
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Installing the DDMs

Important: The installation order within each drawer is from left to right in each row if you are facing
the front of the DCS3700 storage subsystem or DCS3700 with Performance Module
Controllers. You must install DDMs in slots 1, 4, 7, and 10. Ensure that the four DDMs in
each row are adjacent to each other. The long edge of each DDM should touch the DDM next
to it. To maintain a uniform airflow across all drawers, the storage enclosure must be
configured with a minimum of four DDMs in the front row of each drive drawer.

Drive
drawer

Drives

Notes:

1. The drive drawers are preinstalled in the DCS3700 storage subsystem and DCS3700 storage subsystem
with Performance Module Controllers, but the DDMs are shipped separately from the drive drawers.

2. Ensure that you install the storage enclosure in the rack cabinet before you install DDMs in the
storage enclosure.

Drive
drawers

1

2

3

4

5
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To install the DDMs in the drive drawers, complete the following steps:
1. Open the two release levers on the drawer as shown in the illustration. Starting with the top drive

drawer in the storage enclosure, pull the levers on each side of the drawer out and cam away from
the chassis to release the drawer.

Drive drawer levers d
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2. With the release levers fully extended, slide the drawer out until it is fully extended, but do not
remove it from the enclosure.

3. Starting with the first DDM, raise the DDM handle to the vertical position.

13



Raised
buttons

Slots

Latch

4. Align the raised buttons on the sides with the matching slots in the DDM channel on the drawer.
Lower the DDM down onto the drawer, and rotate the DDM handle until the DDM snaps into place
under the DDM release lever.

Notes:

a. If the DDM does not seem not fully seated into the drive connector on the disk drawer, apply
downward pressure to the rear of the drive as you install it.

b. If the storage enclosure is turned on, you must wait at least 90 seconds after you install each DDM
in the drive drawer. Otherwise, the storage enclosure might not recognize the new DDM,
recognize the DDM as failed, or recognize the drive as incompatible. If this happens, unlatch the
DDM, wait 90 seconds, and latch the DDM again.

5. Install the other DDMs in rows from left to right until the drive drawer has a minimum of four
DDMs in the front row of the drive drawer.

6. Push the drive drawer into the storage enclosure until it clicks and close the levers on each side of the
drawer.
Attention: Ensure you push both levers back against the drive drawer completely so that the drive
drawer is closed. If the drive drawer is not completely closed, excess airflow through the unit might
cause damage to the DDMs. If the drive drawer is not completely closed, you will not be able to open
another drawer. If you try to force open another drawer, both drawers might be damaged.

7. Repeat steps 1 on page 13 through 6 for each drive drawer in the configuration.
8. Position the bezel in front of the storage enclosure as shown in the following illustration.

Front bezel Latches

9. Align the tabs on the top and bottom of the bezel with the slots on the front of the storage enclosure,
and align the pins on the side of the bezel with the holes in the storage enclosure. Push the bezel into
the front of the unit until the latches on the sides of the bezel lock it in place.
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Turning on the power

Statement 5:

CAUTION:
The power control button on the device and the power switch on the power supply do not turn off the
electrical current supplied to the device. The device also might have more than one power cord. To
remove all electrical current from the device, ensure that all power cords are disconnected from the
power source.

1

2

Important: You must follow the power sequence in the order shown in the following procedure. To
establish power redundancy for enclosures with two power supplies, use at least two power
distribution units (PDUs) in the rack cabinet. Split the power connections from each enclosure
into the separate PDUs. Then, connect the PDUs to external power receptacles that are on
different circuits.

The storage enclosure accepts only 200 V - 240 V input sources. In addition, you might need
to purchase a special cable for the rack PDUs for the voltage and currents that the DCS3700
or DCS3700 storage subsystem with Performance Module Controllers require. If you do not
have an IBM rack with the supported PDUs and 60 A power cords, check your PDUs or
input sources to ensure that they can handle the DCS3700 or DCS3700 storage subsystem
with Performance Module Controllers' voltage and currents.

To turn on the storage enclosure power in the proper sequence, complete the following steps:
1. Turn off all the power switches on the rear of the storage enclosure. Ensure all of the power cords are

connected.
2. If the main circuit breaker switches in the rack cabinet are turned off, turn them on.
3. Turn on the power switch on each storage expansion enclosure.
4. Turn on both power switches on the storage subsystem.

Note: When you turn off the power to the storage subsystem and storage expansion enclosure,
complete the preceding steps in reverse order. Turn off the power to the storage subsystem
first; then, turn off the power to the storage expansion enclosures.

The following illustration shows the power supplies and the rear view of the DCS3700 storage
subsystem unit. The power supplies are in the same location for the DCS3700 storage subsystem, the
DCS3700 storage subsystem with Performance Module Controllers, and the DCS3700 storage
subsystem expansion unit.
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Installing the software
There are two types of computers that are associated with the storage subsystem. Hosts send
input/output (I/O) to the storage subsystem LUNs. Management stations manage the storage subsystem.
A computer can function as a host, a management station, or both. Use this section to install the IBM
System Storage DS Storage Manager software on a management station or a host.

Note: The latest version of the Storage Manager software for your operating system is on the IBM
Support Web site. See “Obtaining information from the IBM Support Web site” on page 18 for
more information. The version of the software on the DS Storage Manager DVD that came with
your storage subsystem might not be the latest version.

Installing the Storage Manager on a management station
To install the Storage Manager software on a management workstation, complete the following steps:
1. If you have access to the Internet, download the latest version of the Storage Manager software from

the IBM Support Web site (see “Obtaining information from the IBM Support Web site” on page 18
for more information). If you do not have Internet access, insert the DS Storage Manager DVD on the
management workstation and locate the applicable directory for your operating system.

Note: The type of operating system that the management station runs is the directory that you must
locate on the DS Storage Manager DVD. For more information, see the operating-system and
device-river readme files on the DS Storage Manager DVD.

2. Double-click the Storage Manager executable file. Follow the instructions in the setup wizard, and
ensure that you select one of the following options when you are prompted:
v Click Management Station if the computer will be used only as a management station.
v Click Typical (full installation) if the computer will be used as a management station and a host.

3. If this computer is the only computer designated as a monitor, select Automatically Start Monitor
when you are prompted.

Note: If additional computers will manage the storage subsystem, do not click Automatically Start
Monitor when you set up those additional computers. Instead, click Do Not Automatically
Start the Monitor when you are prompted. Otherwise, multiple alert notifications will be sent
when there are problems with the storage subsystem.

Discovering and setting up the storage subsystem
To discover and set up the storage subsystem, complete the following steps:
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1. Connect the management station to the management port of the subsystem. The following illustration
indicates the Ethernet management ports on a DCS3700 subsystem.
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The following illustration indicates the Ethernet management ports on a DCS3700 subsystem with
Performance Module Controllers.
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2. Start the Storage Manager software from your management station. The Enterprise Management and
Confirm Initial Automatic Discovery windows open.

3. Complete one of the following tasks:
v If the DHCP server is set up, select Automatic Discovery from the Enterprise Management Window

to discover the storage subsystem. After the initial automatic discovery is complete, the Enterprise
Management window displays all hosts and storage subsystem that are attached to the local
subnetwork.

Note: Ensure that the management station is under the same DHCP service. To discover storage
subsystem that are outside of the local subnetwork, click Edit > Add Storage Subsystem and
manually enter the IP address of the storage subsystem controller management ports or the
IP address of a remote host.

v If the DHCP server is not set up, set the IP addresses of the storage subsystem controller
management ports to the same subnet of default IP addresses for the controllers.
The default IP address for each controller is as follows:
– Port 1 on controller A is 192.168.128.101
– Port 2 on controller A is 192.168.129.101
– Port 1 on controller B is 192.168.128.102
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– Port 2 on controller B is 192.168.129.102
– The subnet mask for both Ethernet ports is 255.255.255.0

4. Click Rename the Storage Subsystem. Use the serial number of the DCS3700 or DCS3700 storage
subsystem with Performance Module Controllers as the first part of the subsystem name. The host
name has a maximum of 30 characters.

5. Click Locate the Storage Subsystem. A blue LED flashes on the front of the selected storage
subsystem. Label the storage subsystem with its associated name.

6. Highlight the storage subsystem and click Tools > Manage Storage Subsystem to open the Subsystem
Management window and the Task Assistant.

7. If the storage subsystem is not in Optimal state, click the Recover from Failure icon in the Task
Assistant. Follow the steps in the Recovery Guru. When the subsystem is Optimal, close the Task
Assistant.

8. In the Subsystem Management window, click Storage Subsystem > View > Profile. Click the
Controller Firmware, NVSRAM, ESM Firmware, Drive Product ID, and Firmware Versions tabs,
and write each number in the following table for future use.

Controller firmware:

NVSRAM:

ESM firmware:

Drive product ID:

Firmware versions:

9. Save the profile for future use and close the profile window.

Note: Save a copy of the storage subsystem profile and the Collect All Support Data bundle when
you make configuration changes to the storage subsystem.

Installing software on a host
To install the software on a host, complete the following steps:
1. Check the host bus adapter (HBA) BIOS and device-driver versions for your current HBAs. If

necessary, update them to the current level shown on the IBM Support Web site before you install the
software (see “Obtaining information from the IBM Support Web site” for more information).

Note: The BIOS and device drivers for your HBAs should be obtained directly from the IBM Support
Web site. See “Obtaining information from the IBM Support Web site” for more information.

2. Install the multipath driver to manage the paths from the host HBAs to the storage subsystem
controllers. For more information, see the IBM System Storage DS® Storage Manager Version 10
Installation and Host Support Guide.

Obtaining information from the IBM Support Web site
The IBM System Storage documentation that is described in this Quick Start Guide and other IBM System
Storage information is on the IBM support Web site. To access the latest documentation, downloads, and
other technical updates on the IBM support Web site, complete the following steps.

Note: Changes are made periodically to the IBM Web site. Procedures for locating firmware and
documentation might vary slightly from what is described in this document.

1. Go to http://www.ibm.com/systems/storage/support/.
2. In the IBM Support Portal Quick Start window, navigate to your product by expanding System

storage > Disk systems.
3. Select Downloads or Documentation, and click Continue.
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Note: For detailed information about device-driver and firmware versions, ensure that you read the
readme files that are posted with each package.

Updating the storage subsystem firmware

Note: The Storage Manager host code and HBA BIOS and device driver are current, if you completed all
the steps in “Installing the software” on page 16.

In the Subsystem Management Window, click Advanced > Maintenance > Download. Select the
following options in the order listed:
1. Controller firmware
2. Controller NVSRAM
3. ESM firmware
4. Drive firmware

Configuring the storage subsystem
In the Subsystem Management Window, click View > Task Assistant. If the storage subsystem is
Optimal, complete the following tasks in the order listed:
1. Configure alert notification for problems in the storage subsystem
2. Define hosts
3. Create new storage partitions
4. Save configuration
5. Set or change password
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